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Chapter 1: Introduction to the BarTender 
Application Suite 

Overview 
In addition to the main design and print application, the BarTender Application 
Suite includes a variety of additional companion applications and other 
components. Together, they provide a level of power and flexibility not available 
in any other label, barcode, card, tag, part or carton printing software package. 

Depending on the BarTender edition you purchased, some applications may 
only be available for use during the first 30 days after your installation. Except 
as noted, the installed components can be run from the BarTender folder of the 
Windows Start menu. 

BarTender 

BarTender is the main design and print application in the suite. 
Although BarTender first became famous as label and barcode 

software, it is now one of the most versatile design and print applications in 
the world, with powerful additional capabilities for cards (with and without 
magnetic stripe), RFID, tags, film packaging, cartons and more. (RFID 
support is not available in all editions.) 

More Information 
Online Help: Press F1 from within the application. 

The “Using BarTender” chapter in this document covers basic usage. 
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Drivers by Seagull 

Seagull Scientific developed the very first true Windows printer 
drivers for thermal printers. Today we produce the best, most highly-

regarded printer drivers in the world, with support for more than 2,800 
printer models, including label printers, card printers, online printers, and 
others. 

BarTender will work with printer drivers from just about every printer 
manufacturer in the world, including those for laser, inkjet and dot-matrix 
printers. However, BarTender delivers the fastest possible performance when 
using its own Drivers by Seagull™. 

More Information 
See the Installing, Upgrading, and Removing Printer Drivers section of this 
document.  

White paper: 

http://www.BarTenderBarcodeSoftware.com/label-
software/whitepapers/The-Advantage-of-True-Windows-Printer-
Drivers-by-Seagull(English).pdf 

Integration 
All BarTender editions except for Basic can read external data. However, only 
the two Automation editions can be controlled from within other software. Some 
of the methods are summarized in this section. 

More Information 
White Paper: 

http://www.BarTenderBarcodeSoftware.com/label-
software/whitepapers/Barcode-and-Label-Software-Integration-
Methods(English).pdf 

 

http://www.bartenderbarcodesoftware.com/label-software/whitepapers/the-advantage-of-true-windows-printer-drivers-by-seagull(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/the-advantage-of-true-windows-printer-drivers-by-seagull(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/the-advantage-of-true-windows-printer-drivers-by-seagull(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/barcode-and-label-software-integration-methods(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/barcode-and-label-software-integration-methods(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/barcode-and-label-software-integration-methods(english).pdf
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Commander 

(Only supported after 30 days with the two Automation editions of BarTender.) 

Commander is a middleware utility that enables you to control 
BarTender from within other software in situations when it is not 

convenient or possible to do so using the BarTender SDKs. When a software 
application needs to print, it performs a triggering action, such as placing a file 
in a location of your choosing on the network or sending information through a 
TCP/IP socket connection. Commander detects these “triggers” and then 
“wakes up” BarTender so it can automatically generate your print job. 

More Information 
Online Help: Press F1 from within the application. 

White Papers: 

http://www.BarTenderBarcodeSoftware.com/label-
software/whitepapers/Barcode-and-Label-Software-Integration-
Methods(English).pdf 

http://www.BarTenderBarcodeSoftware.com/label-
software/whitepapers/Codeless-Integration-of-Barcode-and-Label-
Printing-with-other-Software(English).pdf 

http://www.BarTenderBarcodeSoftware.com/label-
software/whitepapers/Commander-Examples(English).pdf 

BarTender .NET SDKs 

Before the BarTender .NET SDKs became available, the only way to 
programmatically control BarTender from within other software was through 
BarTender’s ActiveX Automation interface. This continues to be a powerful 
and flexible way to control BarTender. However, .NET programmers now 
have a faster, easier option. The BarTender .NET Software Development Kits 
(SDKs) include pre-written source code and extensive documentation that 
greatly simplify the task of writing code to control BarTender. Now, using 
either C# or VB.NET, you can seamlessly integrate BarTender functionality 

 

http://www.bartenderbarcodesoftware.com/label-software/whitepapers/barcode-and-label-software-integration-methods(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/barcode-and-label-software-integration-methods(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/barcode-and-label-software-integration-methods(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/codeless-integration-of-barcode-and-label-printing-with-other-software(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/codeless-integration-of-barcode-and-label-printing-with-other-software(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/codeless-integration-of-barcode-and-label-printing-with-other-software(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/commander-examples(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/commander-examples(english).pdf
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into your applications without having to write from scratch the most 
commonly-needed routines for automated printing. 

BarTender’s .NET SDKs include:  
♦ Sample source code and project files, including a sample web application 
♦ Extensive documentation 
♦ Integration with Visual Studio 

More Information 
White Paper: 

http://www.BarTenderBarcodeSoftware.com/label-
software/whitepapers/Controlling-Barcode-Label-Software-using-
C-Sharp-and-VB.NET(English).pdf 

System Administration 
Several utilities are included to help you manage and secure your printing 
environment. 

BarTender Security Center 

(Only supported after 30-days with the two Automation editions of BarTender. 
Some features are only available in the Enterprise Automation edition.) 

The BarTender Security Center allows a system administrator to define 
permissions that control which users and groups of users can perform 

specific actions within each application of the BarTender Application Suite. 
For example, you can specify that some users can both modify and print 
templates, while other users are only allowed to print. Security Center also 
supports “Digital Signatures,” which allow you to verify a user’s identity by 
having them enter their password when they perform specific actions. 

More Information 
Online Help: Press F1 from within the application. 

 

http://www.bartenderbarcodesoftware.com/label-software/whitepapers/controlling-barcode-label-software-using-c-sharp-and-vb.net(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/controlling-barcode-label-software-using-c-sharp-and-vb.net(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/controlling-barcode-label-software-using-c-sharp-and-vb.net(english).pdf
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White Paper: 

http://www.BarTenderBarcodeSoftware.com/label-
software/whitepapers/Barcode-and-Label-System-
Security(English).pdf 

Printer Maestro 

(Not all Printer Maestro features listed below are available in all editions 
after the initial 30 days of use.) 

The Printer Maestro software application consolidates multiple print 
management functions within Windows into a single view to make it 

easier to manage printers and print jobs. In addition, Printer Maestro 
introduces exciting new features for managing printer supplies.  

Printer Maestro features include:  
♦ Printer and Print Job Management 

○ Display and manage the status of every printer and print job on a 
network in a single, convenient, customizable view. (Without Printer 
Maestro, Windows has to pop-up a view for each different printer). 

○ Warns you of printer and job errors by email or text message. 
○ Makes it easier to configure printer settings. 

♦ Printer Supplies Management (Enterprise Automation edition only)  
○ Tracks usage of media in printers and transmits “low media” warnings. 
○ Tracks inventory of printing supplies in storage, such as labels, cards, 

ribbon, print heads, etc. and transmits “low inventory” warnings. 

More Information 
Online Help: Press F1 from within the application. 

White Paper: 

http://www.BarTenderBarcodeSoftware.com/label-
software/whitepapers/Enterprise-Print-Management(English).pdf 

 

http://www.bartenderbarcodesoftware.com/label-software/whitepapers/barcode-and-label-system-security(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/barcode-and-label-system-security(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/barcode-and-label-system-security(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/enterprise-print-management(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/enterprise-print-management(english).pdf
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Librarian 

(Available for use after the first 30 days only with the Enterprise Automation 
edition.) 

BarTender Librarian lets large groups of users, designers and 
administrators cooperatively and securely manage the storage and revision 

of BarTender documents and other files. Librarian stores files in the BarTender 
System Database, instead of “loose” on your hard drive. You can then define 
custom states for files (such as Proposed, Approved and Published) and workflow 
management rules for transitions between these states. You can easily view your 
revision history and even rollback to old versions of your files if you need to.  

More Information 
Online Help: Press F1 from within the application. 

White Paper: 

http://www.BarTenderBarcodeSoftware.com/label-
software/whitepapers/Librarian.pdf 

History Explorer 

(Only supported after 30-days with the two Automation editions of BarTender.) 

History Explorer is an application that lets you view logged information 
about jobs you have printed in the past and any messages created by the 

applications that processed the print jobs. History Explorer is required in order to 
be able to audit printing activity with BarTender. For History Explorer to work, a 
BarTender System Database (see the section on BarTender System Database ) 
must be set up to allow logging from the BarTender Application Suite.  

More Information 
Online Help: Press F1 from within the application. 
White Paper: 

http://www.BarTenderBarcodeSoftware.com/label-
software/whitepapers/History-Explorer.pdf 

 

 

http://www.bartenderbarcodesoftware.com/label-software/whitepapers/librarian.pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/librarian.pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/history-explorer.pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/history-explorer.pdf
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Seagull License Server 

(Only required by the two Automation editions of BarTender.) 

Seagull License Server (SLS) is a software utility that monitors and 
enforces the maximum allowable number of printers that can be used 

by the two Automation editions. It runs unattended and invisibly on any 
computer on your network. SLS interacts with BarTender seamlessly so that 
BarTender users need not even know that it is running. 

More Information 
Online Help: Press F1 from within the application. Also see the “Licensing 
Setup Dialog” topic in BarTender’s online help. 

White Paper: 

http://www.BarTenderBarcodeSoftware.com/label-
software/whitepapers/Licensing-for-Bartender's-Automation-
Editions(English).pdf 

System Database Setup 

(For optional use in the two Automation editions of BarTender.) 

System Database Setup is a utility that helps you setup your 
BarTender System Database. It may be hosted by either an SQL 

Server or an SQL Express database. The database is not necessary in order to 
use BarTender, but it is required in order to log information about BarTender 
print jobs and record messages from the rest of the BarTender Application 
Suite. This allows for future auditing using History Explorer and use of the 
Reprint Console. It is also required in order to use Librarian. 

More Information 
Online Help: Press F1 from within the application. 
White Paper: 

http://www.BarTenderBarcodeSoftware.com/label-
software/whitepapers/BarTender-System-Database.pdf 

 

 

http://www.bartenderbarcodesoftware.com/label-software/whitepapers/licensing-for-bartender's-automation-editions(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/licensing-for-bartender's-automation-editions(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/licensing-for-bartender's-automation-editions(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/bartender-system-database.pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/bartender-system-database.pdf
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Printing Utilities 

Web Print Server 

BarTender Web Print Server is an ASP.Net application that comes with the 
Enterprise Automation edition of BarTender. It lets you use most common web 
browsers to connect to and control a centralized copy of BarTender running on 
a server. You can select BarTender documents and output them on a printer 
anywhere on your LAN, WAN, or even to remote printers on the internet. 

More Information 
White Paper: 

http://www.BarTenderBarcodeSoftware.com/label-
software/whitepapers/Web-Based-Barcode-and-Label-
Printing.pdf 

Reprint Console 

(Only supported after 30 days with the two Automation editions of BarTender.) 

Reprint Console allows you to quickly reprint previously printed 
jobs. An entire job, or just a portion of a job can be selected. This is 

particularly useful in automated printing environments, because the sequence 
of actions required to reprint the same job(s) from within other programs 
might be impossible to recreate. For example, information in the other 
program’s database may have changed. Reprint Console requires the use of a 
BarTender System Database, which is discussed in a previous chapter. 

More Information 
Online Help: Press F1 from within the application. 

White Paper: 

http://www.BarTenderBarcodeSoftware.com/label-
software/whitepapers/Reprint-Console.pdf 

 

http://www.bartenderbarcodesoftware.com/label-software/whitepapers/web-based-barcode-and-label-printing.pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/web-based-barcode-and-label-printing.pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/web-based-barcode-and-label-printing.pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/reprint-console.pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/reprint-console.pdf
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Print Station 

The BarTender “Print Station” utility gives non-technical users easy 
“point and click” selection and printing of BarTender documents 

without ever having to see the inside of the BarTender design program.  

More Information 
Online Help: Press F1 from within the application. 

White Paper: 

http://www.BarTenderBarcodeSoftware.com/label-
software/whitepapers/WhitePaper_PrintStation.pdf 

Batch Maker 

(Not supported after 30 days with the Basic edition of BarTender.) 

The Batch Maker utility makes it easy to specify a list of multiple 
BarTender documents to print as a single “batch.” Batches can be 

printed from within Batch Maker itself, as well as from BarTender, Print 
Station and Windows Explorer.  

More Information 
Online Help: Press F1 from within the application. 

White Paper: 

http://www.BarTenderBarcodeSoftware.com/label-
software/whitepapers/WhitePaper_BatchMaker.pdf 

 

 

http://www.bartenderbarcodesoftware.com/label-software/whitepapers/whitepaper_printstation.pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/whitepaper_printstation.pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/whitepaper_batchmaker.pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/whitepaper_batchmaker.pdf
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Chapter 2: Installation and Activation 

Installing the BarTender Application Suite 
The BarTender components you need to install depend on the edition you 
purchased and the features you require. Prior to installation, you should do some 
pre-installation planning, as noted below. After installing the desired modules, 
you will be prompted to activate your software, which is required. (See 
Activation for details.) 

Pre-installation Planning for the Basic and 
Professional Editions 

You will need to decide which PC to install BarTender on. In addition, the 
following Companion Applications will be installed by default: 
♦ Print Station 
♦ Batch Maker (Professional Edition Only) 

Pre-installation Planning for the Automation Editions 

You will need to install a single copy of Seagull Licenser Server (SLS). 
♦ If Running One Copy of BarTender: In this case, SLS and BarTender 

are usually installed on the same computer. 
♦ If Running BarTender on Multiple, Networked Computers: In this 

case, SLS must be installed on a computer that is accessible across your 
network by all copies of BarTender. You can optionally install and run one 
of your BarTender copies on the same computer on which SLS is installed. 

The Installation program can install both SLS and the BarTender Application 
Suite, or you can optionally install just one of these applications. When 



12   BarTender Getting Started 
_______________________________________________________________________  

 

installing the BarTender Application Suite, the following companion 
applications are installed by default: 
♦ Commander 
♦ Security Center 
♦ Librarian (Enterprise Automation edition only) 
♦ History Explorer 
♦ Printer Maestro 
♦ System Database Setup 
♦ Reprint Console 
♦ Print Station 
♦ Batch Maker 

These additional components can optionally also be installed at the same time: 
♦ Seagull License Server 
♦ The BarTender .Net SDKs 
♦ BarTender Web Print Server (Enterprise Automation Edition Only) 

(If you aren’t sure whether or not you need these additional components, you 
can always add them later by running the installation program again and 
choosing the Modify option.) 

For more information about SLS or any of the Companion Applications 
listed above, please see Chapter 1 of this manual. 

Installation Procedures 

To begin installation: 
1. Insert the BarTender CD into your computer’s CD drive. If the 

StartMenu program does not automatically load, manually run 
STARTMENU.EXE from the root folder of the CD. 

2. In the Install section, click BarTender Application Suite and follow the 
instructions given by the installation program. 
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With the Automation editions, some of the companion applications require 
that you create a new BarTender System Database or connect to an existing 
one. Please see the next section for details. 

Installing the BarTender System Database 

(This BarTender System Database topic only applies to the two Automation 
editions.) 

Creating and Managing the System Database 

If you do not already have a System Database installed when you run 
BarTender for the first time, BarTender will ask if you want to run the 
System Database Setup Wizard. You will have the option of using your own 
copy of Microsoft SQL Server as the System Database, or you can use 
Microsoft SQL Express, which comes for free with BarTender. 

If you decide not to run the System Database Setup Wizard right away, you 
can manually select this option in the future from within the BarTender 
folder of the Windows Start menu.  

Logging Data and Storing Files in the System Database 

Most applications in the BarTender Application Suite can log information to 
the System Database. However, each application has its own logging or 
storage options that first need to be enabled. Check the help system for each 
application.  
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Installing, Upgrading, and Removing 
Printer Drivers 

Overview 

Starting with BarTender 8.0, Drivers by Seagull™ began shipping with the 
Seagull Driver Wizard utility. 

A Warning About Microsoft’s “Add Printer Wizard:” 

We strongly recommend that you use Seagull’s Driver Wizard to install, 
remove, and upgrade drivers. The “Add Printer Wizard” that comes 
with Windows does not always properly perform driver upgrades. 

Driver Installation Instructions  
1. Turn off your printer, connect the appropriate cable, and then turn on the 

printer. 
2. If your printer supports Plug-and-Play and you have connected it using a 

USB or Parallel cable, then the Windows Add Hardware Wizard will 
automatically detect the printer and display a driver install dialog. Be sure 
to click Cancel and not install the driver using this Windows wizard. 

3. Instead, from the Install section of the StartMenu program, click Printer 
Drivers by Seagull. 

4. Select Install Printer Drivers and complete the wizard. 
5. Your Seagull driver(s) should now be properly installed. 

Upgrading Printer Drivers 

Do not use the Microsoft Windows Add Printer Wizard to upgrade printer 
drivers. It sometimes does not upgrade all driver files correctly, which leaves 
printer drivers in a corrupted state. 

Instead, use Seagull’s Driver Wizard to upgrade existing printer drivers:  



Chapter 2: Installation and Activation   15 
_______________________________________________________________________ 

 

1. From the Install section of the StartMenu program, click Printer Drivers 
by Seagull. 

2. Select Upgrade Printer Drivers and complete the wizard. 

Removing Printer Drivers 

Driver Wizard may be used to remove printer drivers from the system.  
1. From the Install section of the StartMenu program, click Printer Drivers 

by Seagull. 
2. Select Remove Printer Drivers and complete the wizard. 

Activation 
During the installation, you will have the opportunity to activate your 
software. Activation is a quick, easy, anonymous process that unlocks a 

software product for unlimited use and helps combat software piracy. When you 
choose to activate, an Activation Wizard will run. Click its Help button for 
more information about activation and privacy.  
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Chapter 3: Using BarTender 

Overview 
This chapter guides you through the process of creating and modifying 
BarTender documents and templates. 

Begin by running BarTender. The BarTender Welcome dialog is shown and gives 
you the option of starting a new BarTender document or opening an existing one. 

Documents and Templates 

A template is the design for the label, card, tag, or other item that you want to 
print. You can create many types of objects on a template, including text, 
barcodes, lines, shapes, and pictures. 

Most commonly, your BarTender documents will contain only a single 
template. However, BarTender’s ability to design and save multiple templates 
within a single document and automatically switch between them can greatly 
simplify your integration challenges in more advanced applications. 

Creating a New BarTender Document  

To begin a new BarTender Document: 
1. Select New on the File menu. The New Document Wizard will open. 
2. The New Document Wizard guides you through the steps needed to 

start your document and its associated template(s). 

Among parameters you specify while running the wizard is your preferred 
printer. Doing so before you design your template(s) ensures that all of your 
font options are available and that barcodes are printed at the correct 
dimensions. If you need to make changes to your preferred printer or media 
size in the future, follow the instructions in the next two sections.  



18   BarTender Getting Started 
_______________________________________________________________________  

 

 
A blank template in a new BarTender document. 

Changing the Specified Printer 
1. Click the printer button  on the Main toolbar, or Print in the File 

menu, to display the Print dialog. 
2. Click the down arrow on the right side of the Name option to display a 

list of installed printer drivers. 
3. Click the name of the printer to which you will be printing.  

Note: 

If the desired printer is not listed, use the Seagull Driver Wizard to 
install its printer driver. Refer to Installing, Upgrading, and 
Removing Printer Drivers. 

4. Click Close. 
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Changing the Specified Media Size 
1. Display the Page Setup dialog by either clicking the page setup button 

 on the Main toolbar, clicking Page Setup in the File menu, or 
double-clicking on the blank part of the template viewing area. 

2. Click the Stock tab and select the appropriate manufacturer from the 
Category list. (If the manufacturer of your label, card, tag or other stock 
is not listed, skip to step 4.) 

3. Select the stock from the Stock Name list. (If your stock is not listed, 
proceed with step 4, otherwise click OK.) 

4. Click the Page tab and specify the Page Size and the Orientation 
(either Portrait or Landscape).  

 
5. Click the Layout tab and specify the page margins, and the number of 

rows and columns. (These options are usually available for laser printers 
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only, but occasionally label stock for thermal printers may have columns 
and/or rows.)  

6. Based on the other values in the Layout tab, BarTender by default 
automatically calculates the height and width of your label, card, tag or 
other item to be printed. To override these dimensions, check the Set 
Manually checkbox and enter values into the Height and Width controls. 

7. Click OK. 

Creating a Text Object 
1. Click the create text button  on the Main toolbar. 

2. For a typical text object, select Single Line from the drop down menu. 
3. Move the cursor into the template design area and click where the center 

of the object should be located.  

Note:  

You can also use the BarTender Toolbox to add objects to a template. 
Refer to The BarTender Toolbox below. 

Creating a Barcode Object 
1. Click the create barcode button  on the Main toolbar.  

2. The first time you add a barcode object, the Select Bar Code browser 
appears so you can select the appropriate symbology. From that point on, 
when you click the create barcode button, a drop down list will show 
your previously selected symbologies. If you need a barcode that you 
have not used before, select More Barcodes from the drop down menu. 

3. Move the cursor into the template design area and click where the center 
of the object should be located. 

Creating an RFID Object 
1. Click the create encoder button  on the Main toolbar.  

2. Select the appropriate encoder type from the drop down menu. 
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3. Select the desired properties from the dialog box, and click Close. 
4. The encoder object appears next to the template design area. 

Note:  

RFID support is not available in all editions. 

Selecting and Deselecting an Object 

To select any object, click it. When an object is selected, it has eight solid 
handles, one at each corner and one in the middle of each of the four sides, 
used for resizing the object. Click anywhere away from an object to deselect it.  

Moving an Object 

The easiest way to change the position of an object is to click and drag it to a 
new location using your mouse. 

Refer to Copying, Cutting, and Pasting an Object below for how to move an 
object from one template to another.  

Stretching and Resizing Objects 

An object is resized by clicking it once (to select it) and then dragging one of 
the small handles that appear along the edges of the object. 
1. Select the object and position the pointer cursor on one of the four corner 

handles to resize both height and width. To resize in only one direction, 
position the pointer on one of the side handles. When the cursor is 
properly positioned, it will turn into a thin arrow with points at both ends. 

2. Click and drag the selected handle until the object is the desired size. 
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Copying, Cutting, and Pasting an Object 

Using The Windows Clipboard  
Any object in the template design area can be copied (or cut) and pasted to 
another template, or to another place on the current template, using the 
Windows clipboard and the Copy, Cut, and Paste buttons. See your 
Windows documentation for details.  

Using Click and Drag 
You can also click and drag an object to a new place on a template. Doing 
this with the CONTROL key held down creates a copy at the new location. 

Finally, you can right-click and drag to the desired location. Release the 
mouse button and a pop-up menu appears. Click Copy Here on the menu. 

Deleting an Object from the Template Design Area 

Select the object and press the DELETE key or click Delete on the Edit menu. 
(To remove an object from the template design area, but save a copy of its 
specifications in the Windows clipboard at the same time, use the Cut 
command instead of the Delete command.) 

Specifying the Data Source of a Text or Barcode Object 

Data for the objects in your BarTender templates can come from a variety of 
sources, including: 
♦ Data from databases, including delimited text files, fixed-width text files, 

OLE DB, ODBC (Open Database Connectivity) databases and 
spreadsheets, and SAP™ IDocs  

♦ Data generated from Visual Basic Scripts  
♦ The system date and time on your computer 
♦ Data typed directly into the BarTender document 
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To change an object’s data source:  
1. Double-click on the object whose data source you want to change. The 

Object Properties dialog will be displayed. 
2. In the navigation pane on the left, click on the desired sub-node 

underneath Data Sources. (If this is a new template object, there will 
only be one sub-node.) 

3. Press the Change Data Source Type button  in order to select an 
alternate source. (If you are selecting Database Field as the source and 
have not yet setup a connection to a database, then press the database 
connection setup button  on the Main toolbar. See Setting Up a 
Connection to a Database for Printing below.) 
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To concatenate multiple data sources:  

Sometimes you need to place information from two or more data sources into 
a single barcode or text object. You can do this by concatenating multiple 
data sources so that they are output as a single object. 
1. In the Properties dialog, select either the Data Sources node, or one of 

its sub-nodes. 
2. Insert additional data sources by pushing the New Data Source button  

on the toolbar below the Navigation pane. 

Refer to BarTender’s help for additional data-sourcing topics such as data 
validation, serialization, and prompting. 

Setting Up a Connection to a Database for Printing 

Sometimes it is desirable to print items based on a list of data, such as a parts 
list or a list of customers. This requires reading from a database. BarTender 
can read from the following database types: 
♦ Delimited and Fixed-Width Text Files 
♦ Oracle®, Microsoft Access, Excel, and SQL Server™ 
♦ Other OLE DB Supported Databases 
♦ ODBC (Open Database Connectivity) Supported Databases and 

Spreadsheets 
♦ SAP IDocs  
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To tell BarTender to read from a database: 
1. Open the Database Connection Setup dialog by clicking on the database 

connection setup button  on the Main toolbar. The Add Database 
Connection Wizard will display in the center of the dialog. 

2. The Add Database Connection Wizard guides you through the steps 
needed to configure a connection to your database. 

Refer to BarTender’s help for information about joining tables, reading from 
multiple databases, and specifying queries.  

Changing the Options of a Barcode 
1. Double-click the barcode to display the Barcode Properties dialog. 
2. Click the Symbology and Size node in the Navigation pane on the left 

to display the associated Properties pane. 
3. Modify the properties as desired. 
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Changing the Font 
1. Double-click the barcode or text object. The appropriate Properties 

dialog is displayed. 
2. Click the Font node in the Navigation pane on the left. 
3. Change the typeface name, size, italics, boldness, scale, and script as 

needed. 

Other Modifications to the Properties of Objects 

Double-clicking any object displays the Properties dialog for that type of 
object. Click a node in the Navigation pane on the left to view the 
corresponding Properties pane on the right. 

Importing a Picture 

This procedure should be used when the picture will not be changing with 
each printed label, card, tag or other item.  
1. Click the create picture button  on the Object toolbar. 

2. In the dropdown list that appears, select Insert from File… 
3. Browse for and select the desired picture file. 
4. Click where you want the picture located. 

After you have placed the picture in the template design area, you may 
change its position as explained in Moving an Object above. 

You can also import a picture from a database. Refer to the online help for 
complete instructions.  

Printing  
1. Click the printer button  on the Main toolbar, or the Print option in 

the File menu, to display the Print dialog. 
2. Confirm that the correct printer name is selected. 
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3. If any of the objects in your document use data from a database file, the 
Use Database box should be checked. You can use the database 
connection setup button  to display the Database Connection Setup 
dialog. 

4. Enter the desired number into the Copies control. 
5. Click the Print button. 

Starting with a Preexisting BarTender Document 

BarTender comes with some predesigned documents, most of which contain 
a single predesigned template. If one of them is close to your needs, it may 
be faster for you to modify it rather than design a complete document from 
scratch.  

To start a new document based on an existing document: 

1. Press the File New button  on the Main toolbar to start the New 
Document Wizard. 

2. For the Starting Point, select Existing BarTender Document and press 
the Select… button. 

3. Press the BarTender Documents location button in the Location 
Shortcuts navigation bar on the left. 

4. Browse through the folders and click on documents to see a preview of 
the template. When you see one that you want to use as a starting point, 
press the Open button. 

5. Finish the New Document Wizard. You will now have started a new 
document from a copy of an existing one. 

The BarTender Toolbox 

The BarTender Toolbox provides additional functions and alternative ways 
of accomplishing certain tasks. It contains three panes: 
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♦ Components: This functions as a storage bin in which you save 
barcodes, text, and other objects, or groups of objects, that you have 
configured. Reuse any stored component by dragging it onto a template. 

♦ Data Sources: Use this pane to link objects quickly to particular data 
sources including previously configured database fields or named data 
sources.  

♦ Layers: Use this pane to create, remove or modify layers in the template. 

Getting BarTender Help 
You can access the help system by using any of the following procedures. 

To open the main help window: 

Click BarTender Help menu option in the Help menu. 

To access context-sensitive help: 
♦ From inside of a dialog, click the Help button or press F1. 

For further options in using and customizing the help, see the topic 
Using BarTender's Online Help in the help system. 

For help with Visual Basic select Visual Basic Script Help from the Help 
menu. This will open Microsoft’s full Visual Basic help document in your 
default web browser. 
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Chapter 4: The Commander Integration Utility 

What Is Commander?  
Commander is a software utility, available with the two Automation 
editions of BarTender, that enables you to automatically generate 

BarTender print jobs from other programs in situations where using command 
line or ActiveX automation is either not possible or not cost-effective. 
Commander can be run as an application or as a Windows service. 

When an application needs to generate a print job, it simply creates a triggering 
event (called a “trigger”), such as placing a file in a location of your choosing on 
the network or sending an e-mail to an account of your choosing. Commander 
detects the arrival of this file (or e-mail) and then “wakes up” BarTender so it 
can flow your data into a BarTender document and automatically generate your 
print job. 

A trigger file or message may be empty; but it can also contain data that will be 
read by BarTender, by another application that Commander launches, or by 
Commander itself. Because trigger-creating applications can include different 
content in different triggers, the tasks Commander will execute, and the data it 
uses, can be defined dynamically by the application.  

For example, an in-house order fulfillment application enters data about an 
order into a database and saves an empty file named NewOrder.dat in a 
directory being watched by Commander. Commander finds the file and 
launches BarTender with a document that has been configured to query the 
database about orders entered after a specified time. BarTender reads the data 
and prints the labels, cards, tags or other items. Commander then deletes the 
NewOrder.dat file and resumes monitoring the directory. 
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Common Procedures for Commander 

Launching Commander 

To launch Commander, click its icon on the BarTender branch of the Start 
menu. Below are the steps for the most common tasks.  

Creating or Modifying a Commander Task List 

Commander actions are governed by tasks lists, which identify the triggers 
and the tasks to be performed in response. To create a task list: 
1. Create a new task list file by clicking the new task list button  or 

selecting New from the File menu. If you are modifying an existing task 
list, click the open button  or select Open from the File menu; then 
browse to the task list file and click Open. 

2. Start a new task definition by clicking the create new task toolbar button 

 or selecting Add from the Tasks menu. If you are editing an 
existing task, highlight it and click the properties toolbar button  or 
select Properties from the Task menu. 

3. Use the Task Options dialog to enter details about how to trigger the 
task and to select and configure the commands that will execute when 
the task is triggered, then click OK. 

4. Repeat steps 2 and 3 for every task needed on the task list, and then save 
the task list. 

Deleting, Moving, and Reordering Commander Tasks 

Delete tasks from the list by highlighting the task and pressing the DELETE 
button or selecting Delete from the Edit menu. Use the Cut, Copy, and 
Paste items on the Edit menu to reorder tasks as needed or to move tasks 
from one task list to another. 
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Running a Commander Task List 

To run a Commander task list: 

1. Open a task list by clicking the open button  or selecting Open from 
the File menu. 

2. Enable tasks by highlighting each task you want to execute and selecting 
Enable from the Task menu. 

3. Start trigger detection by clicking the start detection button  or 
selecting Start Detection from the Detection menu. 

For More Information 

There are a number of sources of additional information on Commander.  

Commander Help 
Commander comes with an extensive help system that includes detailed 
examples of Commander in use and additional information about its many 
powerful features. 

White Papers 
These two white papers provide more details about using Commander: 

http://www.BarTenderBarcodeSoftware.com/label-
software/whitepapers/Codeless-Integration-of-Barcode-and-Label-
Printing-with-other-Software(English).pdf 

http://www.BarTenderBarcodeSoftware.com/label-
software/whitepapers/Commander-Examples(English).pdf 

http://www.bartenderbarcodesoftware.com/label-software/whitepapers/codeless-integration-of-barcode-and-label-printing-with-other-software(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/codeless-integration-of-barcode-and-label-printing-with-other-software(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/codeless-integration-of-barcode-and-label-printing-with-other-software(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/commander-examples(english).pdf
http://www.bartenderbarcodesoftware.com/label-software/whitepapers/commander-examples(english).pdf
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Appendix A: Configuring for Performance 

Performance Tips 

Some of the graphics capabilities of Windows, including the ability to print 
TrueType fonts, can result in large amounts of information being sent to your 
thermal printer. Therefore, you should optimally configure your printer and 
personal computer.  

The following tips contain information to help you maximize your printing 
speed and understand the difference between images that are formatted by 
Windows and images that are formatted by your printer. 

Avoid RS-232 Serial Communication Whenever Possible 
Some thermal printers come standard with only a 9-pin or 25-pin (RS-232) 
serial port. A parallel port, USB port, or Ethernet connection may be extra 
options. RS-232 serial communication will work fine if you only intend to 
use your printer's built-in barcodes and typefaces. However, if you want to 
take advantage of any of Windows' graphics capabilities, you will achieve 
significantly better performance if you use a parallel port, a USB port, or an 
Ethernet connection. 

Use Printer-based Objects and Fonts or Downloaded Fonts 
Whenever Possible 
Windows programs often print images, and non-downloadable fonts, by 
drawing them out dot-by-dot using bitmap graphics, a process that can slow 
the printer. Fortunately, many thermal printers can output barcodes, lines, 
boxes, and built-in (or downloaded) scalable text fonts using high-level 
commands. A Windows program can, for example, print using a font built 
into the printer by outputting a few quick control codes, instead of sending a 
large dot-by-dot bitmap drawing of the text image. 
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There are times when a Windows program must output an image as a bitmap. 
So keep in mind, that the more graphics that you send to your printer, the 
slower your printing speed will be. 

Printer Capabilities That Are Not Available To All Programs 

Because most of the special capabilities built into thermal printers are 
different for each brand of printer, and because thermal printers are totally 
different from the more common printers used by Windows, it is just not 
possible for standard Windows programs to access certain high-level thermal 
printer commands. BarTender, however, was designed to take advantage of 
these commands.  
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Appendix B: Printer Driver Troubleshooting 

This appendix presents the best procedure for solving printing problems.  

Step-by-Step Procedure for Solving Printing Problems 

If you are having any problems printing, take the following steps. If this does 
not resolve the problem, contact Seagull Technical Support (Refer to 
Appendix D: Technical Support.) 
1. Check Serial Port Settings: If you are using a serial port, check your 

printer and Windows settings for baud rate, data bits, stop bits and parity. 
(Refer to Serial Port Settings in Appendix C.) 

Do not assume that the “default” printer settings shown in your manual 
reflect your printer’s actual settings. You must directly inspect either the 
mechanical switches (usually on the back of your printer) or the front 
panel menu settings before you can be sure how your printer’s 
communications settings are configured. 

2. Check Cable: Check that the cable is properly connected and attached to 
the correct port on your computer, and that the Windows printer port 
settings accurately reflect the port to which the printer cable is attached. 

3. Print the Printer’s Status Page: To check for mechanical problems 
with the printer, print out from the printer's control panel (not from a 
computer) some document or label that is built into the printer's memory. 
Such documents have different names depending on the printer model. 
They are sometimes called status pages, sample labels, configurations, or 
configuration labels. Consult your printer manual for the exact steps. If 
you are unable to print such a test document or label, you may need to 
have your printer serviced before you can continue with the rest of this 
troubleshooting process. 

Note: 

If you had to adjust a printer switch in order to output your printer’s 
status page, remember to put it back the way it was. 
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4. Reboot Printer: Your printer may not have properly reset after the last 
failed print job or after the last time you made a change to a 
communication setting. Turn the printer off and leave it off for five 
seconds before turning it on again. When it goes on again, make sure it 
completes its self-test procedure before you attempt to print again. (No 
lights should be blinking. Some printers will display the word Ready or 
display a ready light, usually green.) 

5. Print the Driver’s Test Label: For the first print job after steps 1 
through 4, use the Seagull printer driver's Print Test Label feature: 
a. Click the Windows Start button. 
b. Select Settings and then Printers. The Printers folder will be 

displayed. 
c. Click your right mouse button on the printer you wish to change 

your settings for and select the Properties option. The Properties 
dialog opens. 

d. Click the General tab. 
e. Click the Print Test Page button. 

If no label (not even a blank label) comes out and/or you get a printer 
communications error message, proceed to step 11. Otherwise, continue 
with step 6. 

6. Print Device Text From Application: Create a label in your application. 
Use only the fonts built-into your printer, rather than Windows TrueType. 
If this test works, and you do not need to use any graphics or TrueType on 
your label, then you should be able to implement your desired label design 
right away and get back into production. 

7. Print Small Graphics From Application: Add a very small graphic to 
the label, and one letter of TrueType text (such as Arial or Times New 
Roman). This first letter test should be a small size, around 12 pt. 

If the TrueType text and graphic do not print, you may need to upgrade 
the printer's firmware or memory. Consult your printer manual for more 
information. 

8. Print More Graphics From Application: Increase the point size of 
your TrueType text and try printing an entire word or more in TrueType, 
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instead of just a single letter. If this works, then you should go ahead and 
try to print all of the graphics you need on your label. 

9. Diagnose Printer Memory Shortage: If all of your TrueType or bitmap 
graphics print perfectly only so far down the label and then are cut off 
cleanly straight across the label, you have insufficient memory in your 
printer to output the amount of graphics you are attempting to print. 
Contact your printer reseller for a printer memory upgrade. 

In contrast to the clean cut off described in the previous paragraph, if the 
printer outputs incorrect label data, corrupted graphic images, or even no 
label at all, this too may indicate a memory shortage. But, if you are 
using a serial port, it may also indicate a flow control (handshaking) 
problem, as described in step 10. (Always turn the printer off and on 
again following his type of failure.) 

10. Diagnose Serial Port Flow Control Problems: If you are using a serial 
port and a print job stalls and/or generates a communication error 
message after some data has already been successfully transmitted to the 
printer, you may have a flow control problem. 

Test for this by slowing down your printing speed. For example, if you 
had been printing at 9600 baud, try a test print job at the much slower 
rate of 1200 or even lower. (Make the identical change in the port 
settings for both Windows and your printer.) 

If slowing down the baud rate made your problem go away, or caused the 
problem to occur later in the print job, then you should adjust your flow 
control settings. Try switching from software (Xon/Xoff) to hardware 
flow control (or vice versa). Be sure you are using a cable that will allow 
your printer to use hardware flow control. (Consult the printer's manual.) 

11. Diagnose Serial Port Cable Problems: If the Print Test Label fails and 
you are using a serial port, you can test for a cabling problem by 
temporarily turning off flow control (handshaking).  
a. Verify that your printer’s communication settings agree with those in 

your Windows port settings. 
b. Verify that you are using a “null-modem” cable, rather than a 

“straight-through” serial cable. 
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c. Change the Windows Flow Control settings for your serial port to 
None. Then, turn your printer off for five seconds and back on again.  

d. After your printer has finished its power-on self-test, repeat the small 
print job.  

If the print job is successful, you have confirmed that the cable is 
incompatible with the flow control (handshaking) system. Determine 
what is wrong with your cable. Correct it, and then switch back to either 
software (Xon/Xoff) or hardware flow control. 

12. Diagnose Other Problems: If you still can’t print, it is very likely that: 
♦ You have a second hardware product competing for an interrupt 

or I/O address with your communication port.  

or 
♦ You have an advanced Windows setting configured improperly.  

Either way, you need to contact your computer vendor or your company's 
internal computer support staff for assistance.  

Other possible problems: 
♦ A bad (or improperly configured) serial printer cable. For 

example, a simple “3-wire” null-modem serial cable will not 
allow printing from inside Windows unless your flow control is 
set to None. 

♦ The printer cable is attached to the wrong port of your computer.  
♦ A malfunctioning printer port in your computer or printer. 
♦ The printer is off or off-line. 
♦ The computer’s communications port may be conflicting with 

some other hardware component in your computer. 

You will have to rule them out one-by-one in order to solve your problem. 
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Appendix C: Serial Communications 

Overview 

We recommend that you use a parallel port, USB port, or Ethernet 
connection if any of these is available on your printer. They improve printer 
performance and they eliminate confusion about what kind of cable to use.  

However, some printers come with only a 9-pin or 25-pin (RS-232) serial 
port. This section covers some of the most common obstacles encountered 
with such old-style serial port communications and explains how to best 
configure Windows and select the proper serial cable. 

Note: 

A more detailed discussion of serial communication issues is in the 
Serial Communications section of your printer driver’s help. 

Setting and Cable Issues 

If you don't set the serial ports on your computer and printer identically, 
communication will be unreliable. Moreover, there are dozens of ways that 
serial cables can be wired internally and one can't tell by looking at a serial 
cable how it is wired. 

It is important to keep in mind that the program from which you will be 
printing, such as BarTender, does not control the serial communication 
between your computer and printer. Your mode of serial communications is 
controlled by: 
♦ The serial port settings in your printer. 
♦ The serial port settings on your computer. 
♦ The type of serial cable being used. 
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Serial Port Settings 

Serial communication is governed by the following parameters. These must 
be set identically on both the printer and the computer. 
♦ Baud Rate: This is the rate at which your printer will receive data (in 

bits-per-second). Common values are 2400, 4800, 9600, 19200, 38400, 
and 57600; with 9600 being the most common default setting. You want 
to set the highest rate at which your printer will work reliably. Use trial-
and-error to find this rate after you have set your other serial 
communication parameters. 

♦ Data Bits (sometimes called “Word” length or byte length): This specifies 
the number of bits used to encode each character sent to your printer. The 
most common value is 8, although older printers may default to 7.  

♦ Parity Bit: This is an optional extra bit sometimes sent after the data bits 
of a transmitted character for the purpose of error checking. The possible 
settings are Odd, Even, and None. 

♦ Stop Bits: This is the length of the pause at the end of a transmitted 
character. One stop bit is the most common setting. 

♦ Flow Control (sometimes called “Handshaking”): This can be set to 
software (also called Xon/Xoff) or hardware. Never use the None 
setting for Flow Control. Disabling flow control can result in 
intermittently corrupted or completely failed print jobs.  

Note: 

Refer to the topic Understanding and Setting Flow Control 
(Handshaking) in your printer driver's help for more information about 
choosing a handshaking method.  

Setting Serial Parameters on your Printer 

You control serial port settings for your printer with either DIP switch 
settings or through a menu system accessed from the printer's front panel. 
Consult your printer's documentation for details. 
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Most printers do not allow changing all of the above parameters. Consult 
your printer manual to determine what settings are required, and be sure to 
make identical settings in Windows. 

Setting Serial Parameters in Windows 

You first specified your serial port settings when you installed your printer 
driver, but if you need to change them, follow the procedure below to 
configure your serial port. 
1. Click the Windows Start button. 
2. In Windows 2000, 2003 and XP, select Settings and then Printers. In 

Windows Vista, select Control Panel and then Printers. In Windows 7, 
select Start, then Devices and Printers. The Printers (or Devices and 
Printers) folder will be displayed. 

3. Click your right mouse button on the printer you wish to change your 
settings for and select the Properties option. The Properties dialog 
opens. 

4. Click on the Ports tab. 
5. To check your port settings, click on the Configure Port button. The 

Port Settings will be displayed. 
6. Adjust your port settings as necessary and click OK. 
7. Click Close to exit from the printer’s Properties dialog. 

Using the Correct Serial Cable 

Because a printer and computer both use serial ports that have their inputs 
and outputs on the exact same pins, a wiring configuration must be 
established that crosses over the outputs from one port to the corresponding 
inputs of the other port. A serial cable that connects signals by crossing them 
over in this manner is referred to as a null modem cable. By contrast, a 
straight-through serial cable, often used to connect a computer to a modem, 
connects pins 1, 2, 3, etc. on the computer to pins 1, 2, 3, etc. on the modem. 
If a straight-through serial cable were attached to a printer, an output signal 



42   BarTender Getting Started 
_______________________________________________________________________  

 

from the computer would go, not to an input pin of the printer where it can 
be received, but to an output pin of the printer where it would be ignored. 

Note: 

Some newer thermal printers do require a straight-through cable. If 
there is any doubt, you should consult the documentation provided by 
the manufacturer. 

Cabling and Flow Control (Handshaking) 
It is also possible to cross over other lines so that the printer can offer the 
hardware handshaking option. (Refer to Serial Port Settings above.) Thus, it 
is important to consult your printer's manual to determine what cable is best. 
Some general purpose cable configurations, though they may contain more 
wires than all printers require, will work for a great variety of printers.  

Note: 

Refer to the help for your driver for pin and wiring diagrams of the null 
modem cables most commonly used by thermal printers, and for a 
special note on grounding. 
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Appendix D: Technical Support 

If you still have questions after consulting this manual and the help system, 
Seagull’s Technical Support Department can be reached at the phone numbers 
and e-mail addresses below. Faxed technical support requests receive a faxed 
response. Internet technical support inquiries receive an Internet response.  

You Must Register Your Software to Receive Support 

Register your product online at: 

http://www.BarTenderBarcodeSoftware.com/aspx/registration.aspx  

Unless you register your product, you will not receive technical support. 

You Must Call From Next to Your Computer 

When calling for technical support, it is very important to call from a phone 
right next to a computer that is running BarTender. This makes it much easier 
for our technical support personnel to assist you. 

About Tech Support for Visual Basic Script  

Technical support for Visual Basic Scripting is limited. For information on 
support limitations, please refer to Technical Support, A Note on Technical 
Support for Visual Basic Scripting in BarTender’s help. 

Technical Support Contact Information 

Please see next page. 

http://www.bartenderbarcodesoftware.com/aspx/registration.aspx
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Seagull Scientific, Inc. – USA, Canada & Latin America 
Voice Telephone: 1 425 641 1408 
FAX: 1 425 641 1599 
Internet: TechSupport@SeagullScientific.com 

Seagull Scientific Europe, Inc. – Europe, Middle East & Africa 
Voice Telephone: +34 91 435 55 45 
FAX: +34 91 578 05 06 
Internet: EuroTech@SeagullScientific.com 

Seagull Scientific Asia-Pacific, Inc. 
Voice Telephone: +886 2 3765 2440 
FAX: +886 2 3765 2467 
Internet: AsiaTech@SeagullScientific.com 

Seagull Scientific Asia Pacific: Japan Branch Office 
Voice Telephone: +81 3 5847 5780 
FAX: +81 3 5847 5781 
Internet: JapanTech@SeagullScientific.com 
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Index 

A 

Access, Microsoft, 24 
activation, 11, 15 
Add Database Connection Wizard, 25 
asking for help, 28 
Automation Editions, 2, 4, 5, 6, 7, 8, 13, 29 

B 

bar code 
changing symbology of, 25 
changing the size of, 21 
creating, 20 
moving, 21 

Batch Maker, 9 

C 

clipboard, 22 
Commander, 3 
Commander integration utility, 29 
Commander program 

common procedures, 30 
contacting Seagull Scientific. See 

Seagull Scientific, contacting 
context-sensitive help, 28 
copy 

object, 22 
creating a new format, 17 
creating objects 

bar code or RFID, 20 
importing pictures, 26 
text, 20 

D 

data source 
changing specified, 23 

data sources 
concatenating, 24 

database 
creating and managing, 13 
logging data to, 6, 13 
reading data from, 22, 24 
setting up a connection to, 25 

date 
as object data, 22 

deleting an object, 22 
dialog 

Barcode Properties, 25 
Database Connection Setup, 27 
Page Setup, 19 
Print, 18, 26 
Properties, 26 

dialog (Commander) 
Task Options, 30 

document 
creating, 17 
preexisting, 27 
reprinting, 8 
revision history, 6 

documents 
premade, 27 
supplied by Seagull Scientific, 27 

downloadable fonts, 33 
driver installation 

Seagull Driver Wizard, 14 
driver removal, 15 
driver upgrades, 14 
driver wizard, 14 
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E 

Enterprise Automation edition, 5, 8 
erasing an object, 22 
Ethernet connection 

better than RS-232, 33, 39 
Excel, 24 

F 

flow control 
of serial ports, 37, 42 

G 

graphics 
importing, 26 

H 

handles, 21 
handshaking 

of serial ports, 37, 42 
height 

changing bar code, 21 
changing text object, 21 

help system 
asking for help, 28 

History Explorer, 6 

I 
importing pictures, 26 
installation 

of BarTender System Database, 12, 13 
of Batch Maker, 11, 12 
of Commander, 12 
of History Explorer, 12 
of Librarian, 12 
of Print Station, 11, 12 
of Printer Maestro, 12 
of Reprint Console, 12 

of Seagull License Server, 12 
of Security Center, 12 

integration 
trigger based, 3 
using BarTender's .NET SDKs, 3 

Internet address for Seagull Scientific, 44 
interrupt or I/O address conflict, 38 

L 

Librarian, 6 
logging. See database, logging data to. 

M 

margins 
page, 19 

Microsoft Access, 24 
Microsoft Excel, 24 
Microsoft SQL Server, 24 
moving an object, 21 

N 

New Document Wizard, 17 
null modem cable, 37, 41 

O 

ODBC 
reading data from, 22, 24 

OLE DB, 22, 24 
Oracle, 24 
orientation, 19 

P 

parallel port 
better than RS-232, 33, 39 

pictures 
importing from database, 26 
importing from file, 26 
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position 
changing an object's, 21 

predesigned documents, 27 
predesigned templates, 27 
preexisting documents, 27 
preexisting templates, 27 
Print Station, 9 
printer 

changing specified, 18 
supplies management, 5 

Printer Maestro, 5 
printer-based objects and fonts, 33 
printing, 26 

a test label, 35, 36 
cards, 1 
labels, 1 
performance tips, 33 
RFID, 1 
tags, 1 
troubleshooting, 35 

printing templates, 26 
properties 

of objects, 26 

R 

reading data from a database, 24 
reading from a database, 22 
registering BarTender, 43 
removing an object, 22 
Reprint Console, 8 
RFID object 

creating, 20 
RS-232 serial port, 33, 39 

S 

SAP 
reading data from, 22, 24 

screen. See dialog. 
screen data, 22 

Seagull License Server, 7 
Seagull Scientific 

contacting, 43 
Security Center, 4 
selecting 

objects, 21 
serial cables, 41 
serial communications, 39 
serial port 

parameters, 40 
serial port parameters 

of printer, 40 
of Windows, 41 

size 
of template. See template size. 
paper, 19 

SQL server, 24 
stock, 19 
straight-through serial cable, 37, 41 
supplies management. See printer, 

supplies management. 
support 

technical, 43 
Symbology, 25 
System Database Setup, 7 

T 

task list 
creating/modifying in Commander, 30 
running, 31 

tasks on task list 
deleting, moving, and reordering, 30 

technical support, 43 
telephone numbers for Seagull 

Scientific, 43 
template height and width 

specifying, 20 
template size 

changing specified, 19 
templates 
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pre-made, 27 
supplied by Seagull Scientific, 27 

text object 
changing the height of, 21 
creating, 20 

time 
as object data, 22 

toolbox, 27 
tracking printer consumables. See 

printer, supplies management. 

U 

USB port 
better than RS-232, 33, 39 

V 

Visual Basic, 22, 28 

W 

Web Print Server, 8 
window. See dialog. 
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